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Glossary

Application Programming Interface (API)

Defines a set of routines, communication protocols and tools for building software. In general, they are clearly
defined methods for communication between different components.

Bill of Materials (BOM)

Defines a list of assemblies, sub-assemblies, parts and their quantities needed to produce a final product.
BOM position

Defines a position in the BOM with unique identification, name, quantity and other characteristics.
Component Object Model (COM)

Defines a binary-interface standard for software components introduced by Microsoft.
Connector

Defines a central interface component of each Dassault integration. The integration uses connectors for each
participating application to exchange data via their API.

Datamodel

Defines objects and their relationships in a PLM system that are managed by the integration to store data from an
authoring application.

Dynamic Link Library (DLL)
Defines a file with a library of functions and other information that can be accessed by a Windows program.
Payload

Defines the data contained within an API request. The description is borrowed from the transportation industry,
where a truck carries its cargo (its payload) to a location. The truck, as with the API request, is always the same, but
the payload changes with each request.

Product Lifecycle Management (PLM)

Defines systems and processes for managing data during the development of a product from creation through
manufacturing to maintenance and disposal.

Revision
Defines a released object state in SOLIDWORKS PDM that cannot be modified.
Script engine

Defines the central component in each integration. It contains the integration logic for processing and forwarding
the information and data coming from the connectors.

User Interface (Ul)

Defines a (usually) graphical interface through which a user interacts with the computer.
Version

Defines an incremental counter of each object modification in SOLIDWORKS PDM on check-in.
x86/x64

Defines the processor architecture in a computer and thus also the performance of applications. x86 corresponds to
32-bit and x64 corresponds to 64-bit.
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1 Introduction
1.1 Getting started

Introduction

1.1  Getting started
The SOLIDWORKS PDM - Creo Parametric integration supports users when working with PTC Creo Parametric
data. The integration is directly embedded in Windows Explorer as well as Creo Parametric.
SOLIDWORKS PDM offers CAD specific file format support in two ways:
m file format plug-ins and
®  CAD add-ins.
The file format plug-in is a DLL file that executes calls for certain CAD file formats in the context of Windows
Explorer API to read and write properties and file references and to preview managed files.
The add-in is a DLL loaded with a specific application, e.g. Creo Parametric. It offers possibilities to display
extended menu options (ribbons, context menu) in the application and to simplify the work with the files.
The supported Creo Parametric formats are:
®  Creo Parametric part (.prt)
®  Creo Parametric assembly (.asm)
®  Creo Parametric drawing (.drw)
®  Creo Parametric section/sketch (.sec)
®  Creo Parametric formats (.frm)
®  Creo Parametric layouts (.lay)
102 Add-in
Ribbon bar
The SOLIDWORKS PDM ribbon bar contains all features of SOLIDWORKS PDM and are executable for the
loaded root element. The following functions are available:
Function Title
[% Open File
é Check In
{_—‘% Check Out
Ef_) Undo Check Out
@ Get Latest Version
% Get Version
User Guide www3ds.com 7/28



1 Introduction
1.2 Add-in

Function Title

Show Properties

Update Title Block

Rename

Change State

Search

Select in Windows Explorer

) File Info

@ | (88 O | ¥4l @

View Tree in Browser

Context menu

The SOLIDWORKS PDM context menu contains features of SOLIDWORKS PDM and is executable for the
selected element. The following functions are available:

B Check out, Check in and Undo check out

®  Show Properties (Data Card)

B Rename

®  Change State

®m  Search

®  Selectin Windows Explorer

® File Info

® \iew Tree in Browser
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2 Functional description of the Creo Parametric add-in
2.1 OpenFile

Functional description of the Creo Parametric add-
in

2.1 OpenFile
L
Open File opens a browser, which allows selecting files that are
B available on the local disc.
®  not available on the local disc, but stored in the SOLIDWORKS PDM database.

2.2 ChecklIn/Check Out
Files can be checked in or checked out from the SOLIDWORKS PDM vault or from the Creo Parametric add-in.
The following chapter explains the functions via Creo Parametric.
Check In
With Check In changes of the currently checked out object and its structure are saved and checked in to
SOLIDWORKS PDM. Changes can affect structure, geometry of parts, appearance and file properties. After
analyzing the structure, the SOLIDWORKS PDM Check In dialog appears.
In the dialog, the modified objects are displayed in bolt. It also shows that the version increases for
modified files which are selected for check in. Objects that are already checked in, can only be viewed and
changes cannot be saved to SOLIDWORKS PDM. Modifications of a file in status Checked in is possible, but it
needs to be checked out in order to perform a Check In action. Furthermore, the user can add a description
about the changes in the Comment line.
Check Out

Fad

7
Selecting the Check Out command opens the SOLIDWORKS PDM Check Out dialog.
In the dialog, the user can select the desired files (including the complete structure). Warnings and error
messages are also displayed, e.g. if a user has already checked out a file.
On pressing Check Out in the dialog, the selected files are checked out.
Undo Check Out
Undo Check Out removes the reservation of the current user for the corresponding CAD file inside
SOLIDWORKS PDM database. The function is used to discard local changes and reload the last checked in
version of the object.
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2 Functional description of the Creo Parametric add-in
2.2 CheckIn/Check Out

@ Before Check Out, Check In and updateTitleBlock a read-only file will be closed, a MessageBox
appears, asking the user if he wants to abort the selected process.
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2 Functional description of the Creo Parametric add-in
2.3 Load Versions

2.3

Load Versions

Use these functions to load desired versions from SOLIDWORKS PDM to Creo Parametric.

Get Version

R

With Get Version a desired version of the selected object can be loaded from SOLIDWORKS PDM. On
selecting this function, a history dialog appears showing all available versions, the current local version
and the check in comment of the selected version. After confirming the dialog, the Get dialog appears. All
available versions can be selected and loaded. Usually the files, whose versions have to be replaced on the
client, are preselected. When clicking Get, the current used version is replaced and the object is reloaded in
the selected version.

The function can be used for checked in and checked out objects.

‘ If edits were made to the file and it was not checked in first, performing this operation replaces the
current file and the edits are lost.

Please note that files cannot be checked out if they're loaded in older version.
If you want to change a file in older version then execute following workaround:

1. Go to the latest file version.
2. Check out thefile.

3. Goto an older version.

4. Make changes.

If you check in the file, then a new file version (latest + 1) is created.

Get Latest Version

h

The function Get Latest Version is similar to the function Get Version. The history dialog is not necessary
in this case. The files that are available on the client in an older version are marked and preselected. After
selecting Get, the current used version is replaced and the object is loaded in the latest version.

The function can be used for checked in and checked out objects.

“ If edits were made to the file and it was not checked in first, performing this operation replaces the
current file and the modifications are lost.
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2 Functional description of the Creo Parametric add-in
2.4 Properties

2.4 Properties
A property is a piece of metadata that can be exchanged bi-directionally between SOLIDWORKS PDM and
Creo Parametric. Properties are usually saved in CAD files and in SOLIDWORKS PDM fields and can be
accessed from the Creo Parametric’s user interface as well as from SOLIDWORKS PDM masks.
Show Properties

=0

Show Properties displays the Data Card for the local version of a file. The data in the Data Card can be
changed when the affected file is checked out. The changes also affect CAD file properties if the changed
variable is part of the data mapping (refer to Installation and Administration Guide for more information) and
vice versa.
After the check in, the data of the Data Card is stored in the vault.
Some metadata displayed in the SOLIDWORKS PDM may have configuration specific values.
To bidirectional exchange such metadata from Creo Parametric to SOLIDWORKS PDM, make sure that the
corresponding Creo Parametric parameter is used within the Creo Parametric family table.
If the current object in Creo Parametric is a drawing, there is the command Update Title Block.
This command allows updating Creo Parametric parameter, visible in a title block of a drawing by retrieving
the corresponding values from SOLIDWORKS PDM.
Update Title Block
[wav;;
Title blocks of drawings can be automatically populated by using the Update Title Block menu item that is
only available within the drawing context of Creo Parametric.
This function automatically populates the title blocks of the currently loaded drawing (if it has a title block)
with information gained from SOLIDWORKS PDM. This function transports document data of the drawing,
related items, referenced models and its existing items.
The Update Title Block function is a property exchange and can be configured (please refer to the
Installation and Administration Guide for details).
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2 Functional description of the Creo Parametric add-in
2.5 Rename

2.5 Rename
With Rename, Creo Parametric files can be renamed in SOLIDWORKS PDM. Refer to chapter Renaming (p.
23) for more information.
2.6 Workflow Management
Workflows represent the development process. They define the life cycle of a document, project, or process
by specifying the states a document goes through.
Change State
SOLIDWORKS PDM supports work with workflows by default. This allows tasks in the development process
to be structured in terms of time, content and logic.
Allfiles in a vault are usually assigned to a workflow. Workflows can be created and configured in the
Administration Tool.
With the function Change State, the user can move the selected element from the initial state to the target
state, if he has the necessary rights. To do this, the user receives the transitions available for the initial status
via the selection dialog Select a transition.
For example, starting from the status Change Pending Approval, the two transitions Change Approved
and Change Editing Required are offered. With selecting a status and pressing OK, the Do Transition dialog
appears.
The dialog offers the possibility to select the affected files and to add a comment to the status change.
Pressing OK, executes the status change.
If rights are missing for the status change, an adequate error message appears.
Changes of the workflow status are only possible for files that are checked in. If the user tries to change the
status of a checked out file, the user is prompted to check in the file first. When selecting Yes, a check in is
executed for the affected files and the state is changed. When selecting No, the status change is aborted.
User Guide www3ds.com 13/28



2 Functional description of the Creo Parametric add-in
2.7 Explore

2.7 Explore
In this section, interactions with the Windows Explorer are described.
Search
With Search the user has the possibility to start the standard search of SOLIDWORKS PDM from Creo
Parametric. This tool can be used to search for files and folders in the vault using various masks, such as the
Creo Parametric Search Card. The user can search by file name, for a specific variable value in a data card, by
workflow state, user name, etc.
The result list offers the same features as the Windows Explorer.
Loading search results into Creo Parametric is possible from here.
If not already logged in, the command shows the SOLIDWORKS PDM login dialog.
Select in Explorer
The command opens a Windows Explorer showing the current vault. The file representing the current/
selected object is preselected. If not already logged in, the command shows the SOLIDWORKS PDM login
dialog.

2.8 Display PLM Information
File Info
5
Use the File Info command to display SOLIDWORKS PDM information of the current/selected object.
The name of the file, which is the headline of the info page, is displayed in
u , if the object is loaded in the latest version.
m  red, if the object is loaded in an old version.
u , if the object is checked out and locally modified.
If the file is checked out, but not yet modified, the headline is displayed with cyan background color.
Contents of this HTML page can be customized. Refer to the Installation and Administration Guide for more
information.
View Tree in Browser
Use this command to display SOLIDWORKS PDM information for the current/selected objects and its
structure.
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2 Functional description of the Creo Parametric add-in
2.8 Display PLM Information

The name of the file, which is the headline of the info page, is displayed in
u , if the object is loaded in the latest version.
®  red, if the object is loaded in an old version.

u , if the object is checked out and locally modified.

If the file is checked out, but not yet modified, the headline is displayed with cyan background color.

The background color of the columns of the table corresponds to above logic too, except that the cyan color
is not used, instead standard grey column background.

Contents of this HTML page can be customized. Refer to the Installation and Administration Guide for more
information.
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3 Functional description of the SOLIDWORKS PDM add-in
3.1 Lock

3.1

3.2

3.3

Functional description of the SOLIDWORKS PDM
add-in

The following use cases explain different possibilities to work with the integration. Some of the functions
open Creo Parametric on executing if it is closed.

Lock

To modify an element, it needs to be checked out. It is possible to select

B asinglefiles
® multiple files
B asingle folder

®  or multiple folders

for check out. After selecting Check Out from the context menu, the Check Out dialog appears and displays
all selected files with their structure.

Check In

With the command Check In the assembly structure is resolved and created in SOLIDWORKS PDM.
After the check in, all affected files are checked in and the tab Contains displays the file structure.

The Check In command is available for files and folders and can be accessed via the context menu of the
vault. If Check In is executed for folders, all contained files are checked in and created in SOLIDWORKS PDM.

Hints for settings in the Administration Tool

In the Administration Tool of SOLIDWORKS PDM it is possible to define, which files and folders should be
added to the vault during import and which not. Open the Administration Tool and navigate to User >
Settings > Adding Files/Adding Folders.

These settings are relevant for the performance.

Undo Check Out

Via this function of the context menu, check outs can be canceled.

Any local changes made to the selected element are discarded.

3.4 Edit data card variables
The metadata is displayed within the Data Card tab of Windows Explorer. On checked out files, the user
can modify the metadata. Clicking the Save button, SOLIDWORKS PDM stores the changes within the
SOLIDWORKS PDM database and also within the Creo Parametric file.
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3 Functional description of the SOLIDWORKS PDM add-in
3.5 Get Latest Version

3.5 GetLatest Version
The function Get Latest Version of the context menu is used to retrieve the latest version of the current
element.
3.6 History
Via the History function, the version and workflow transition history of an element can be displayed. The
History lists comments, revision numbers, creation dates and names of users who modified each version.
This functionality allows retrieving old versions of files from SOLIDWORKS PDM by pressing the Get button.
3.7 Change State
With Change State, the user can move the selected elements from the initial state to the target state, if he
has the necessary rights.
3.8 Cut/Delete
Cut/Delete erases the file from the SOLIDWORKS PDM database, too. However, if this file is used in
¢ any other object, then there will be missing files!
3.9 Rename
The Rename command within Windows Explorer allows renaming of
B Drawings and sections
B Parts, Assemblies, Layouts and Formats, that are not referenced by any other object
g We strongly recommend using the Rename command within Creo Parametric as described in
® chapter Renaming (p. 23) instead of using the Rename command within the Windows Explorer.
0 Drawings and assemblies may be corrupted after executing the Rename command via the Windows
¢ Explorer, especially when:
B renaming parts that are referenced by a drawing. The drawing is ALWAYS corrupted. It is not
loadable anymore to Creo Parametric.
B renaming objects used on different levels within the structure. It will fail to update the references
within all parent assemblies.
®  when retrieving outdated versions from SOLIDWORKS PDM using either the Get Version
command of the Creo Parametric integration or the Get command within the History dialog
of Windows Explorer, the resulting file will be corrupted and won't be loadable into Creo
Parametric.
This is primarily true for:
O drawings, that reference renamed parts or assemblies.
o assemblies with multiple references to renamed objects on different level.
User Guide www3ds.com 17/28



3 Functional description of the SOLIDWORKS PDM add-in
3.10 Copy Tree

3.10 Copy Tree
' Using the rename functionality within the function Copy Tree is not supported. References within
¢ other assemblies/drawings are getting corrupted.
Therefor we recommend using the function File > Save As > Save a copy from Creo Parametric and
the rename capabilities there.
When not using the rename functionality of Copy Tree, the new files appear in the destination directory and
they are added to the vault. They are in status Checked out. No structure information is available. Now the
user can execute the Check In command, which generates the structure information (as usual).
3.11 Move Tree
When not using the rename functionality
®  and there are no external dependencies, then the command can be used successfully. The moved files
appear in the destination directory. Since Creo Parametric does not store file paths, there is no need to
update any references.
B and there are external dependencies, the search path within Creo Parametric must contain the
destination directory. If that's the case, the command can be used successfully.
Using the rename functionality is not supported. References within other assemblies / drawings will be
corrupted.
Workaround: Use File > Save As > Save a copy from Creo Parametric using the rename capabilities
there. Then delete the original files manually.
3.12
Deletes all files within the selected folder from the local disc. The files are still available in the SOLIDWORKS
PDM database, and can be retrieved with the History or Get Latest Version command. This command is
supported but may lead to problems, i.e. a drawing using a part from a cleared folder, then this drawing is
not loadable anymore, as long as the file appears on the folder again.
3.13 Preview
To preview part and assembly files, it is necessary that eDrawings is installed.
Preview of drawing, layouts, sections and formats is not supported.
3.14 Conversion functions
If the task functionality is configured, data can be converted via the context menu in the SOLIDWORKS PDM
vault. The following file types can be created:
®  Conversion commands for 3D models (.asm, .prt)
o STEP
O IGES
User Guide www3ds.com 18/28



3 Functional description of the SOLIDWORKS PDM add-in
3.14 Conversion functions

®  Conversion commands for drawings (.drw)
O DXF
O PDF

The converted files are created in the specified directory.

Files which are currently opened in Creo Parametric are closed without any warning after executing
¢ atask process.
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4 Using the integration - best practices
4.1 Loggingin

Using the integration - best practices

4.1 Loggingin
How can the user establish a connection to the SOLIDWORKS PDM vault?
If the user is not connected to his vault, the vault selection dialog appears as soon as a SOLIDWORKS PDM-
related function (e.g. Search or Select in Windows Explorer) is used. After selecting the desired vault, the
login dialog appears.
On restarting the Creo Parametric application, the user has to select a desired vault again. The user does not
necessarily have to log in again.

4.2 Importing files and folders
How can the user import files and folders to SOLIDWORKS PDM vault and perform an initial check in?
Summary
SOLIDWORKS PDM offers the possibility to import existing models in a simple way. This requires a local vault
view and an installed file format plug-in.
The import is divided in two steps:
= Copy and Paste
® Checkin
As aresult,
m  allfiles and folders are added to the vault
m files and folder properties are written into SOLIDWORKS PDM variables if a mapping of variables exists
®  structural information between files is created (tabs Contains and Where Used)

Pg All files, which were imported in this way, get version 1. The import of version chains is not possible.
In this case, use the SOLIDWORKS PDM XML Import Tool.

Copy and paste
It is possible to select and copy as many files and folders as wanted in the Windows Explorer and to paste
them into the vault.
0 We recommend to close everything in Creo Parametric and to clear the session before copying files.
During the paste process, all file and folder objects are added to SOLIDWORKS PDM and the SOLIDWORKS
PDM variables are filled as defined in the mapping for variables. Assembly structures are not considered in
this step (see tab Contains).
All available files are checked out and do not have a status.
0 We do not recommend to use special characters for new names.
When pasting Creo Parametric version files to a vault, the system automatically removes the version
extension before adding the file to the SOLIDWORKS PDM database.
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® [ the base file of a version file already exists and is in state Check in, the pasted version file is
ignored.

® |f the base file of a version file already exists and is in state Check out, the contents of the version
file is copied into the base file.

®  |f multiple version files of the same base file are pasted in one step, only the one with the highest
version number is saved to the vault.

Refer to the Installation and Administration Guide for more information.

Reference Files/Search Paths

Creo Parametric is not a native Windows application like SOLIDWORKS, and because of this, certain methods
of opening, saving and accessing files need to be well understood and accepted

Since Creo Parametric does not store the full path information for referenced files like SOLIDWORKS does,
Creo Parametric needs to be told where to look for references. Even though SOLIDWORKS PDM knows the
folder location of files referenced by a Creo Parametric assembly or drawing, Creo Parametric does not find
them unless the files are in any of the following locations (shown in order of search):

®  session memory (RAM)

m  directory where the user selected the parent file from

specified Working Directory
®  search paths called out in either the config.pro or the search.pro file

It is therefore important that a search.profile be maintained with all necessary folder paths.

4.3 Setting working directory
Creo Parametric has what is called a Working Directory which establishes the default location for new files
and as a standard location where reference files are searched for.
The location of the Working Directory can be defined in different ways. The Working Directory can be set:
®  to the base folder of the vault by adding a value for the variable xP1mWork within the file <swpDpM
INSTALL DIR>\CAD Integration\SOLIDWORKS Corp\SOLIDWORKS PDM\CAD Integration\com
\config\xplm-proe.cfg, e.g C:\SOLIDWOKRS PDM\My Vault.
®  to the base folder of the vault by customizing the file config.pro.
®  manually by the user via the Creo Parametric function Select Working Directory.
P9 The Open File command of the integration menu is affected by the settings in xplm-proe.cfg, not
by the settingsin config.pro.
4,4 Storing new objects to a SOLIDWORKS PDM vault
How can a user save objects to the vault?
In order to save a newly created object, use the standard Save command of Creo Parametric and navigate
to a directory within a SOLIDWORKS PDM vault. Clicking OK stores the file and automatically adds the file to
SOLIDWORKS PDM.
Using the Creo Parametric command Save As with option Save a Copy stores a copy of the files to the
selected directory and, if within a vault, automatically adds the file to SOLIDWORKS PDM.
User Guide www3ds.com 21/28



4 Using the integration - best practices
4.5 Searching for documents

0 Before using the Check in command, it is necessary to store the object beforehand.

Templates
The Creo Parametric templates for assemblies, parts, drawings and so on can be used.

Itis possible to store those template files in a special folder within the vault and access it from there with a
definitionin config.pro,e.g. template solidpart C: \MyVault\Templates\standard.prt.

4,5 Searching for documents
How can a user search for documents?
Procedure
1. Activate the command Search in Creo Parametric.
2. Inthe opened SOLIDWORKS PDM search tool, enter a string in the field NAME and press Enter.
The search tool searches through the vault and displays all hits.
3. Inthesearch results area, right-click a search result and select Open.
Result
The selected file opens in Creo Parametric. If Creo Parametric is not available, it is started automatically.
4.6 Assembling existing components
How can a user assembly existing components?
The Creo Parametric command Assemble is used to add existing components to an active assembly file.
This command also uses the File Open dialog of Creo Parametric. Thus, if a user tries to browse to a file
that is not locally cached then he is not able to see it. The recommended procedure to use the assemble
command is to first perform a search in SOLIDWORKS PDM via the Search function of the integration menu
and drag the desired file from the results area of the SOLIDWORKS PDM Search tool into an active Creo
Parametric assembly window. The other option is to get a local copy of the desired file (if necessary) from
the results and then use the Assemble command in Creo Parametric and browse to the file.
4.7 Opening files
How can a user open files in Creo Parametric?
There are many ways to load a file from the SOLIDWORKS PDM vault into Creo Parametric:
1. Usethe Open File[g command from the integration. This opens a browser, which allows to select files,

A. that are available on the local disc.

B. that are not available on the local disc but stored in the SOLIDWORKS PDM database. The path of the
opened directory can be defined in the xpilm-proe.cfgfile, located in <swPDM INSTALL DIR>\CAD
Integration\SOLIDWORKS PDM\CAD Integration\com\config

2. Use the normal Open functionality of Creo Parametric. This opens a browser, which allows selecting files,
that are available on the local disc.
3. Select afile within Windows Explorer and double-click it.
4. Select afile within Windows Explorer and right-click the file and select the Open command or use Open
with and select PDMPFileOpener.
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5. Drag the file from Windows Explorer and drop it into Creo Parametric.
6. Use the Search function to search for desired files and to open them in Creo Parametric.
4.8 Renaming
How can a user rename files?
Renaming via Creo Parametric
Preconditions
B The current/selected object is stored in a vault directory.
®  The current/selected object is available within SOLIDWORKS PDM.
B The user has the rights to rename the object.
B The current/selected object is not checked out by someone else.
After clicking £ Rename a small dialog appears, where the file name can be adapted. Make sure, that
®  anew name is provided.
®  the new name does not contain illegal characters.
®  the new name does not exceed the maximum length of 31 characters.
When clicking CANCEL, the command ends.
When clicking OK, the command performs:
B 3 Where-Used analysis.
B acheck, whether all where-used documents are in status checked in or checked out by the current user.
If not, there is an error message and the command ends.
® a3 check, whether any where-used document is currently checked out by the current user.
In that case a question box with
The following objects are checked out and will be checked in during this rename action: (followed by a list of all
checked out objects)
Do you really want to rename?
is displayed. Clicking No, ends the command, clicking Yes continues the rename process.
B 3 check, whether the number of all where-used documents is larger than a threshold.
If yes, a question box appears with the following content
The file is currently used in XXX other files: (followed by a list of all these file names - maximum number of files
displayed is 50 - if there are more than 50, then another line is added: and YYY more objects).
Do you really want to rename?
Clicking No, ends the command. Clicking Yes starts the rename process.
® 3 check out action of all where-used documents, that are not yet checked out by the current user.
B 3load action, to load all where-used documents in Creo Parametric session.
B arename in SOLIDWORKS PDM.
B arenamein Creo Parametric.
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4.9

4.9.1

B asave action to store all changed objects to local disc.
®  acheck out and check in action (with option overwrite) of the renamed document.

® 3 checkin action (with option overwrite) of all where-used documents.

Getting older versions

When retrieving outdated versions from SOLIDWORKS PDM using either the Get Version command of
the Creo Parametric integration or the Get command within the History dialog of Windows Explorer, the
resulting file will be corrupted and won't be loadable into Creo Parametric.

This is primarily true for:

®  drawings, that reference renamed parts or assemblies.

®  assemblies with multiple references to renamed objects on different level.

Checking files in and out

The following use cases explain different possibilities to check files in and out.

Checking out & in - assembly
How can a user check out and in a 3D model with its structure?

Before you start
Assembly and its structure is available in SOLIDWORKS PDM and checked in.

Procedure
1. Open an assembly with its structure in Creo Parametric from SOLIDWORKS PDM.

2. Press Check Out from the integration menu Creo Parametric.
The SOLIDWORKS PDM Check Out dialog appears and shows a mark in the column Check out for the top
element only.

3. Press Ctrl+L to select all objects for check out and confirm with the button Check Out.
-> When the command is finished, all files are checked out.
4, Verify that the check out was successful.

a) In Creo Parametric, press View Tree in Browser from the integration menu.

-> Browser opens and displays the currently opened structure. Column Checked out by user and
Checked out in folder are filled with the correct information.

b) Inthe SOLIDWORKS PDM Windows Explorer, the file of the top element and all its child elements are
marked as checked out by the current user.

5. Modify all objects (change the parts geometrically/move objects below assembly) in Creo Parametric.

6. Press Check In from the integration menu in Creo Parametric.
The SOLIDWORKS PDM Check In dialog appears and shows marks in the column Check in for all objects.
Make sure that there is no warning listed in the column Warnings.

7. Inthe SOLIDWORKS PDM Check In dialog, confirm with the button Check In.

User Guide

www3ds.com 24 /28



4 Using the integration - best practices
4.9 Checkingfilesin and out

4.9.2

4.9.3

Result

®  When the command is finished, all files are checked in.
®  The columns Checked out by user and Checked out in folder in browser are empty.

®  |nthe SOLIDWORKS PDM Windows Explorer, the file of the top element and all its children are not marked
as checked out.

® Theversion isincreased by 1.

Checking out & in - shrink wrap

How can a user check out and in shrink wraps?
About this task

Creo Parametric allows to create shrink wraps. This is done by generating cyclic references (The shrink wrap
assembly is the parent of the shrink wrap part - but the shrink wrap part has a reference to the shrink wrap
assembly again).

Checking in such data in SOLIDWORKS PDM may result in a wrong structure. It depends on the sequence of
the files which are checked in. To get a proper result, do the following.

Procedure
1. Restart Creo Parametric (to get rid of cached data).

2. Checkin the shrink wrap assembly and the shrink wrap parts in one step using the Check in command of
Creo Parametric.

3. Checkin any other assemblies referencing the shrink wrap parts.

Checking in - families of parts

How can a user check out and in families of parts?

SOLIDWORKS PDM allows to store configuration specific structure. Within the Contains tab of Windows
Explorer the user can select between the following modes:

® Do not show configuration

B Generic

®  Configuration 1

®  Configuration 2

Configuration n

However, due to performance reasons the SOLIDWORKS PDM - Creo Parametric integration does not store
all configuration-dependent structure.

The following options are available:

®  Only displaying the structure of the generic configuration. Structure of all configurations is empty.

® Displaying the structure for the generic and the active configuration. Structure of non-active
configurations is empty. This is the default setting.

B |nquiring the generic structure and displays it for generic and for any configuration.

Refer to the Installation and Administration Guide for more information.
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4.10

4.10.1

4.11

Getting versions
The following tasks describe how to get different versions from SOLIDWORKS PDM vault.

Getting versions of assemblies and drawings

How can a user load desired versions in Creo Parametric?
Before you start

®  Create an assembly with two parts.
®  Create a drawing of the assembly.

® |nitially check in the drawing and the assembly by using the Check In command in Creo Parametric > all
objects get version 1.

®  Check out the drawing and the three objects.
®  Geometrically change the two parts.
®  Update the drawing and add a dimension.

®  Check in the drawing and the three objects by using the Check In command from drawing - all objects
get version 2.

®  Repeat the check out, modification and check in - all objects get version 3.

Procedure

1. Bringthe drawing to the foreground and press Get Version from the integration menu in Creo
Parametric.

2. Inthe upcoming dialog, select version 2 from the table and click OK.
The SOLIDWORKS PDM Get dialog appears and shows marks for all four objects. Local version is 3/3 and
version is 2/3.

3. Inthe SOLIDWORKS PDM Get dialog, press the button Get.

=> Version 2 is loaded in Creo Parametric.

4, PressView Tree in Browser from the integration menu.

=> Browser opens and displays the structure. All rows are displayed in red because the files are not up-
to-date.

5. Press Get Latest Version from the integration menu in Creo Parametric.

-> The Get dialog appears and shows marks for all four objects. Local version is 2/3 and version is 3/3.
6. Press Get in the SOLIDWORKS PDM Get dialog.
Result

Reload process starts. After the reload has finished, all files are loaded in version 3. Browser does not show
the rows in red anymore.

Adding parameters

How can a user add parameters?

Creo Parametric uses parameters to store file properties like description and part number. The parameters
can be accessed by selecting Tools > Parameter. SOLIDWORKS PDM reads and writes to these parameters.
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4.12

The parameter names cannot contain spaces. Therefore, do not use spaces when defining variable attribute
names in SOLIDWORKS PDM, use underscores instead.

Variables should be defined using the CustomProperties Block Name in the SOLIDWORKS PDM Edit variable
dialog. To update title block information by changing variable values in SOLIDWORKS PDM, use the note
syntax sparameter name in adrawing note to link the note text to a drawing parameter value.

Example: If the parameter name is REVISION and its value is B, and REV &REVISION is entered in the note text.
The note displays REV B.

Restrictions

Reloading objects opened in multiple windows

If the object, to be reloaded, is opened in multiple windows, Creo Parametric does not allow to reload the
data. Therefore we added a check upfront and, if such a case is detected, an error message appears. The
commands Get Version, Get Latest Version and Undo Check Out are cancelled without retrieving data
from SOLIDWORKS PDM.

Using files with the same name on different folders

Creo Parametric does not allow to load different files with the same name from different directories. So it is
not possible having a structure as shown in the following example:
® Assembly

O Partl (loaded from <vault-dir>/Test1)

O Partl (loaded from <vault-dir>/Test?2)

When copying files with the same name to different directories within the vault, make sure, that the Creo
Parametric session is cleared before every paste action.

The following is an example of how to work with files with the same name in different directories:

1. Create atest file with the following structure and save the files to the same vault directory (e.g.
<vault-dir>/testl):
B Drawing
o Format
o Part
Check in the files.
Clear the session information in Creo Parametric.
Copy thefiles to another directory in the same vault (e.g. <vault-dir>/test2).
Check in the files.
Restart Creo Parametric.
Go to the first directory (e.g. <vault-dir>/test1) and check out the three test files.
Modify the three files (e.g. by editing meta data on the data card)

© ©® N U R WD

Check in the files again and verify that the structure is correct. Therefore check tab Contains for the top
element.

10. Clear the session information in Creo Parametric.
11. Checkout the three test files stored in the second directory (e.g. <vault-dir>/test2)
12. Modify the three files (i.e. by editing meta data on the data card)
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13. Check in the files again and verify that the structure is correct. Therefore check tab Contains for the top
element.

Version files as template files

Creo Parametric integration does not support using version files as template files.
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